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Terminology and TLAs
We will explore how APL can interact with and use some of these technologies:
OLE - Object Linking and
sharing properties and methods of applications by combining and exposing
Embedding
objects within a standard framework (eg. document)
& OLE Automation

(Wikipedia:) the formal interprocess communication mechanism based on COM.
It provides an infrastructure whereby applications can access and manipulate (i.e.
set properties of or call methods on) shared automation objects that are exported
by other applications. It supercedes DDE. The OLE Automation controller is the
"client" and the application exporting the automation objects is the "server".

COM - Component Object
Model

(MS 2000 Automation Help:) an industry-standard technology that applications
use to expose their objects, methods, and properties to development tools, macro
languages, and other applications. (DCOM = COM extended for network apps.)

DCOM - Distributed COM

(Wikipedia:) ...often used in the software development world as an umbrella term
that encompasses the OLE, OLE Automation, ActiveX, COM+ and DCOM
technologies.
OLE Server

a usually invisible application which supports the main interface (client)
(MFC:) an Automation server is an application (a type of COM server) that
exposes its functionality through COM interfaces to other applications, called
Automation clients. The exposure enables Automation clients to automate certain
functions by directly accessing objects and using the services they provide.
(Dyalog Help:) The OLEServer object allows you to export an APL namespace
so that its functions and variables become directly accessible to an OLE
Automation client application such as Microsoft Visual Basic or Microsoft Excel.

OLE Client

the application interface or application which controls or calls upon the OLE
Server.

ActiveX Control

a usually visible object which user interacts with; may be embedded in another
application.
(Wikipedia:) a Microsoft term that is used to denote reusable software
components that are based on Microsoft Component Object Model (COM).
ActiveX controls provide encapsulated reusable functionality to programs and
they are typically but not always visual in nature.
(Microsoft:) an ActiveX control is implemented as an in-process server (typically
a small object) that can be used in any OLE container.

Object Oriented

numerous meanings, but generally: a modular approach, using reusable units
(called object, class, control, etc.) with common design, including properties,
methods, and events; (nouns, verbs, things that happen?)
(APL+Win:) an instance of any class is an object.
consider an everyday example: book

ADO - ActiveX Data
Objects

MS specification for interfacing to databases, using ActiveX/COM structure and
methodology

DAO - Data Access Objects

older MS specification for database access, similar to ADO; see:
C:\Program Files\Common Files\Microsoft Shared\DAO\DAO35.hlp

ODBC - Open Data Base
Connectivity

older MS specification for interfacing to databases via SQL queries
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Dyalog APL - Terminology
OLEClient

object that enables your APL application to interact with non-APL objects (eg.
Excel)

OLEServer

created by converting an APL Namespace to an object (APL workspace or .dll),
which is then referred to by any non-APL application (eg. Excel); requires
dyalog.dll to run

OCXClass

object used to access non-APL-derived ActiveX controls
(OCX being one of several names associated with this class of objects)

ActiveXControl

stand-alone object created by APL, but accessed from non-APL applications;
requires dyalog.dll to run - based on a Dyalog Namespace object

ActiveXContainer

"read-only"; used to represent the application that is hosting an ActiveXControl
object, and provides access to its ambient properties (eg. Font, colour) (see:
OLEQueryInterface Method, etc.)

GUI Memory

use '.' (root object), and Áwc, Áwn, Áws, Áwg to identify and explore

GUID or CLSID

Globally Unique IDentifier or CLaSs IDentifier - Windows handle

Let's take a glimpse of some of these things,

'.' Áwg 'PropList'

Æ root level properties

±C¢'.' Áwg 'OLEControls'
¸C

Æ Windows registry OLE Controls

±S¢'.' Áwg 'OLEServers'
¸30¸S

Æ Win-registry OLE Server objects

(ª/(±¸S)±ª/¤(º'xcel')Ú¤,¸S)Ê¸S

Æ Excel objects?

References


Dyalog session Help menu - "GUI Help" and "Latest Enhancements"



Dyalog Interface Guide (book or download .pdf)



Excel Help menu



Auto2000.chm - Microsoft Office 2000 automation Help file, available at:
http://support.microsoft.com/default.aspx?scid=http://support.microsoft.com:80/support/kb/articles/q260/4/10.asp&NoWebContent=1



MFC - Microsoft Foundation Class Library - online resources,
eg. http://msdn2.microsoft.com/en-us/library/fe1cf721.aspx



APL+Win workspaces and documentation
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Client? Server? and other Options
Noting all of the above, what do you really want to do? It boils down to a few possibilities:
1) In APL (development session), or an APL-GUI (runtime) application - you write data to Excel, etc., eg.
format and print; further processing, eg. charts), or you read data into your APL environment from Excel.
2) In Excel - you call upon APL functions to perform calculations, run an existing APL utility, read an APLdriven database etc. and return results, or you send Excel data to an APL system and have it processed there.
3) Other OLE Options - eg. create ActiveX controls using APL; use non-APL ActiveX objects from within
APL; use ADO for database access; etc.
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Excel - Components and Overview

Excel's Object-Oriented Structure
In very brief terms, the Excel spreadsheet is a hierarchical collection of objects; objects have properties; most
have methods; and when we interact with these objects - events take place. This is the model we must work with
to program such applications from any point of view, including APL.
Excel Help provides a good visual display of these objects, and an in-depth resource for understanding how to use
these: for starters, try:
"Contents and Index" > "Microsoft Excel Visual Basic Reference" > "Microsoft Excel Object Model"
(it's Microsoft, so your version may differ!)
This diagram displays the hierarchical relationships between objects. Click on any of these to explore the details
further down the branches of the tree to expand further levels. Notice the top-level object is called "Application".

Key Excel Components and Concepts
Obvious
Menu

Windows standard

Toolbars

one or more; contain tool buttons, combos, etc.; user may modify

Formula Bar

input area

Name Box

give a name to a cell or range

Workbooks

collection object containing individual Workbooks, ie. opened *.xls files, each one
being a Workbook object

Worksheets

(or Sheets) collection object; tabs at bottom-left; add, delete, move

Rows/Columns

A1:Z99 designation; some maximum values; note Rows numeric, Columns alpha;
drag/drop heading areas to resize; Ctrl-down-arrow etc.

Cells

contain values or formulas; many properties to consider: datatype, format, font,
behaviour, alignment (text left, num right), etc.
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Office Automation with Dyalog APL

6

Dyalog '06

Not so obvious
Selection

Method and Property; drag/drop to select one or more contiguous cells, or whole
Rows/Columns/Worksheets; highlight and modify content or format

Collection

special Excel object used to contain other objects, eg. Workbook > Worksheets; Item
and Count properties are useful; special syntax needed in APL

Item

Property; collection object unit; demo: select cells, hit Enter key repeatedly

Count

Property; collection object unit count

Range

ambiguous term: span of cells (Property) vs. Range Object; defines a collection of
cells (like an array), either contiguous or non (may even span Worksheets)

PrintOut

and other Methods; eg. print an object; Open, Close, Quit, Select, Activate, etc.

numerous subobjects

various commonly-used objects and nomenclature such as UsedRange, ThisWorkbook,
ActiveSheet, ActiveChart, etc.

VBA/Macros;
GUI elements

GUI objects and code stored as part of the spreadsheet; macro recording facility; builtin edit and debug environment

Now, let's go back to APL. First, we need to spend 5 minutes on:

APL GUI Programming - 101 (very lite)
In all APLs, object programming is accomplished with some handy Œ-functions
Dyalog
ÁWC = create
ÁWS = set
ÁWG = get
ÁWN = names
ÁDQ = wait
ÁNQ = invoke

and...

Examples

'F'ŒÁWC 'Form'
'F'ŒÁWG 'PropList'
'F'ŒÁWG 'Size' 'Posn'
'F'ŒÁWS 'Caption' 'Hello World'
'F' ÁWS 'BCol' 255 0 0
'F.B1'ŒÁWC 'Button' 'OK'('Event' 'Select' 'ÎÁEX''F''')
'F.ED1'ŒÁWC 'Edit'('Posn' 10 10)
ÁWN 'F'
ÁDQ'F'
F.Caption¢'Goodbye World'

In similar fashion, we can take this methodology, and apply it to the Excel object, or other COM objects.

APL Borealis Inc. - www.aplborealis.com
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Exploring the Excel Object (from APL)
From APL, to use an OLE object as a server, we create an OLEClient object, which is implemented like a
"namespace" in Dyalog APL, and we associate a particular server object with it, eg.:

ÁWX ¢ 1

Æ see: "New External Object Behaviour" below

'XL' Áwc 'OLEClient' 'Excel.Application'
This creates an OLEClient object which will interact with an OLE Server, with the ClassName property as
specified from our list of OLEServers, ie. from the Root Object property which examines the Windows Registry.
'xl' becomes a namespace object which we can explore or query and use. Dyalog provides system commands to
enable us to explore a namespace's objects:

)CS XL
)methods
)events
)props
Version
LibraryPath
Columns.Count

Æ enter the "xl" namespace
Æ list properties

The above can also be accomplished via Áw_ syntax from the root level:

)CS
'XL'
'XL'
'XL'
'XL'
'XL'

Áwg
Áwg
Áwg
Áws
Áws

'MethodList'
'Version'
'Visible'
'vIsIBLe' 1
'Visible' 0

Æ return to root level
Æ
Æ
Æ
Æ

Excel version number (may be important)
is the server visible?
make it so; does case matter?
make it not

Dyalog also allows the use of direct object/property naming via "." syntax, eg.

XL.PropList
XL.Version
XL.Visible
XL.Visible¢1
XL.visible¢0
XL.Rows.Count

Æ suddenly, case matters! (and AutoComplete helps a lot)

Interesting diversion...

XL.Speech.Speak 'Are we having fun now? Or what?'
XL.Speech.Speak 'hey dood, this is sew, koole'
XL.Speech.Speak 'hasta la vista, mi amor'
XL.Speech.SpeakH'wut, in, hayl, yoo, thank, yer, dooon, bo ah?'

Also, Dyalog provides the "Workspace Explorer" tool to browse such objects.
Want to find out what any of these properties, methods or events really means? For starters, try searching for the
particular term in the Excel/VBA Help feature.

APL Borealis Inc. - www.aplborealis.com
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Some Key Points
• Dyalog implements GUI memory and OLE objects using the namespace concept, hence )OBS or ÁNL lists
these; )CS or the object.object syntax allows us to explore, etc.; )ERASE or ÁEX erases the object;
assignment ¢ is used to set properties; ÁNQ or object.object syntax is used to invoke methods; even the each
operator ¤ can be put to use for implicit looping, etc.
• upper/lower case-sensitivity varies when addressing properties, methods and events (according to the syntax
used?)
• Dyalog AutoComplete - displays object Properties; useful to explore objects to some extent
• Incorrect usage often returns a useful response, eg. Methods are indicated by APL del symbol Õ when invoked
but missing an argument, eg. XL.Columns.AutoComplete or in fact an "Exception Error" may appear in a
separate "Status" form, eg. try XL.Workbooks.Open with an invalid path/filename.
• Visibility - is Excel visible in the task bar? Processes in Task Manager? etc.; set the Visible property
• Is Excel already running?
see: http://apldn.apl2000.com/Discussion+Groups/APL+Win+Interpreter/APL+Interpreter+General/797.aspx.htm
• Which 'Excel.Application' server object name to use?
see: "How to run multiple versions of Excel on the same computer"
http://support.microsoft.com/kb/214388
•

ÁWX and Version 11.0 External Object Behaviour
see: Language Help > ÁWX > External Object Behaviour

• 3 ÁNQ invokes a method in an OLE Control. The (shy) result of ÁNQ is the result produced by the method.
• Collection Objects - can be confusing, require special syntax, see below

APL Borealis Inc. - www.aplborealis.com

Office Automation with Dyalog APL

9

Dyalog '06

Collection Objects
Consider these definitions from the Excel-Help:
Workbook Object - The Workbook object is a member of the Workbooks collection.
Workbooks Collection Object - A collection of all the Workbook objects that are currently open in the
Microsoft Excel application.
Workbooks Property - Returns a Workbooks collection that represents all the open workbooks. Read-only.
Worksheet Object - Represents a worksheet. The Worksheet object is a member of the Worksheets collection.
The Worksheets collection contains all the Worksheet objects in a workbook.
Worksheets Collection Object - A collection of all the Worksheet objects in the specified or active workbook.
Each Worksheet object represents a worksheet.
See also: ActiveWorkbook; ThisWorkbook; Sheets; ActiveSheet; etc.
In other words, the many objects, levels and similar terms can be confusing. The main points are that collection
objects have a special purpose and syntax, and we may refer to the objects they contain by using the Item
property or equivalent reference via indexing. Compare the following:
First, look for this file or equivalent: 'c:\Program Files\Microsoft Office\Office\Library\common.xls', then:

'XL' Áwc 'OLEClient' 'Excel.Application'
XL.Workbooks.Count
XL.Workbooks.Open 'c:\... \common.xls'
XL.Workbooks.Count
XL.Workbooks.PropList
(XL.Workbooks) ÁWG 'PropList' (vs. 'XL.Workbooks' ÁWG 'PropList' ?)
(XL.Workbooks.Item 1).PropList
XL.Workbooks[1].PropList
XL.Workbooks[1].Name
WB1 ¢ XL.Workbooks[1]
WB1.Name
WB1.Sheets.Count
Collection objects are typically a part of the hierarchy or path to get to the underlying information in the
spreadsheet. The key Collection Objects include: Workbooks, Sheets (Worksheets), Rows, Columns, Range.
Use ...Item N or indexing (via [ N ] ) to select a Collection Object Item

APL Borealis Inc. - www.aplborealis.com
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APL in Control
First, look for this file or equivalent: 'c:\Program Files\Microsoft Office\Office\Library\common.xls', then find a
second .xls file on your system to open, then work through these examples:

'XL' ÁWC 'OLEClient' 'Excel.Application'
XL.Workbooks.Open 'c:\... \common.xls'
XL.Workbooks.Open 'c:\... \secondspreadsheet.xls'
XL.Workbooks.Count
XL.Workbooks.PropList
XL.Workbooks.Item
XL.Workbooks.Item 1
(XL.Workbooks.Item 1) Áwg 'PropList'
(XL.Workbooks.Item 1).PropList
WB1¢XL.Workbooks.Item 1 Ï WB2¢XL.Workbooks.Item 2
WB1.Name Ï WB2.Name
DISPLAY (WB1.Sheets.Item¤°WB1.Sheets.Count).Name
WB1.Sheets[1].PropList
WB1.Sheets[1].Cells
WB1.Sheets[1].Cells.Range
(WB1.Sheets[1].Cells.Range 'A1' 'D5').PropList
(WB1.Sheets[1].Cells.Range 'A1' 'D5').Value2
(WB1.Sheets[1].Range 'A1' 'D5').Value2
M¢WB1.Sheets[1].UsedRange.Value2
ÁNULL×¤M
WB1.Sheets[1].UsedRange.Cells.Count
WB1.Sheets[1].UsedRange.Rows.Count
WB1.Sheets[1].UsedRange.Rows[4].Value2
WB1.Sheets[1].UsedRange.Columns[4].Value2
To Create a new Workbook (spreadsheet) and Write to it (the basics):

WB3¢XL.Workbooks.Add 1
(WB3.Sheets[1].Range'A1' 'E5').Value2¢5 5±°25
XL.Visible¢1
(WB3.Sheets[1].Range'A1' 'E5').Value2¢°25
WB3.SaveAs 'APL2XLdemo1.xls'
WB3.Path
WB3.Close 1
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Datatypes, Formatting, and Related Issues
COM objects such as Excel typically have data represented by more datatypes than those available in APL. Excel
datatypes for example include: Boolean, Date/Time, Double, Error, Integer, Long, String, Currency, Variant.
When transferring data back and forth between APL and Excel therefore, we may need to pay attention to the
datatype of our data to make sure it is both stored and represented (displayed) correctly.
• APL provides Ánull (displayed as [Null] ) which is used to represent null values which COM methods
often return. Other data conversions for data transferred between systems are automatic
• Value vs. Value2? (from Excel-Help)
"The only difference between (the Value2) property and the Value property is that the Value2 property doesn't use
the Currency and Date data types. You can return values formatted with these data types as floating-point
numbers by using the Double data type." (ie. use Value2)
In some cases?? ...Value seems to require a null argument, eg.

(WB3.Sheets[1].Range'A1' 'E5').Value 

• IS Functions (from Excel-Help) - use these to determine particular characteristics of cells, eg.
XL.ISNUMBER XL.Workbooks[1].Sheets[1].UsedRange
This returns a 2-cell result with a boolean array in cell-1, indicating cells with numeric values (presumably of any
of the numeric datatypes?).
• Information Functions (from Excel-Help) - further IS_ functions to return characteristics of cell contents.
Note that not all of the above IS_ functions are available - see XL.MethodList - ie. some Methods are "exposed",
others are not (?); and the list seems to grow as these are used (??).
• Formula vs. Value?
Enter some formulae on a spreadsheet, then compare ...Range.Value2 vs. ...Range.Formula
• Create your own worksheet function?
see: http://office.microsoft.com/en-us/assistance/HA010548461033.aspx
eg.

Function HYPOT (D1, D2)
HYPOT = (((D1 ^ 2) + (D2 ^ 2)) ^ 0.5)
End Function

...says you need to "...copy the function into a workbook used as a function library and compile that workbook as
an add in program..."
• APL+Win offers root-object-level query & set functionality for data type and value (see the VT_VV
workspace).
• Under-filling cells results in "#N/A", eg.

(XL.Workbooks[1].Sheets[1].Range'D15' 'F17').Value2¢2 2±°4

APL Borealis Inc. - www.aplborealis.com
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Dates
Dates are stored in Excel as a day-count number (days since 1900-01-01) but typically represented (displayed) in
other ways, such as '16-Oct-06'. Make sure your date information in Excel is numeric and not a character string
that looks like a date. There are several display options, see Format > Cells > Number > Date in the Menu, or In
in Excel-Help, see: "Available Number Formats" > "Display numbers as dates or times" > "Custom date and time
codes".
When calculating day-count values, note that Excel incorrectly counts 1900 as a leap year, hence dates are offset
by 1 between APL and Excel (see DateToIDN Method in Dyalog GUI Help > IDN definition).
Some examples: (open a spreadsheet... enter some dates, numerics and text if not already present...)

WB1¢XL.Workbooks.Item 1
RNG1¢WB1.Sheets[1].Range'A1' 'A7'
RNG1.NumberFormat
RNG1.NumberFormat¢'yyyy/mm/dd'
RNG1.NumberFormat¢'###.####'
RNG1.NumberFormat¢'$###.00'

Æ choose any appropriate range with dates
Æ and have a look at the Excel result

)COPY C:\...\WS\UTIL SM_TS TS_SM DISP
TODAY¢SM_TS 3¸ÁTS
WB2¢XL.Workbooks.Add 1
Æ create a new Workbook, write some numbers and dates
RNG2¢WB2.Sheets[1].Range'B3' 'F7'
RNG2.Value2 ¢ (TODAY+0,°4),5 4± 0.001¥100?10000
WB2.Sheets[1].Range'B3' 'B7').NumberFormat' ¢ 'dd-mmm-yy'
(...and a bit of formatting, etc.)

RNG2.Font.Size ¢ 14 Ï RNG.Font.Italic ¢ 1
RNG2.Interior.Color ¢ 256 ´H0 0 255
RNG2.Interior.ColorIndex ¢ 44
Æ some pre-set colours
RNG2.ClearFormats
RNG2.ClearContents

APL Borealis Inc. - www.aplborealis.com
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Utilities
Rather than invent most of the wheels...
First, find or create an Excel spreadsheet that has more than one worksheet, and some data (numeric or char or a
mixture) in a few cells. Then:

)LOAD ...\samples\ole\oleauto

(in the Dyalog install folder)

DESCRIBE
Reading a spreadsheet

±mat¢XLCONTENTS 'C:\...common.xls'
±¤mat

(etc., explore the structure of the result)

Examine XLCONTENTS, (or XLCONTENTS1) and note how control structures are used to navigate through
Excel's object hierarchy and collection objects.

Writing To a Spreadsheet

)ED XLPRINT

(modify it to not PrintOut, Close or Quit, and remove EX from the header)

mat2¢10 10±0.1¥100?1000
1 XLPRINT mat2

(note EX object, EX.Visible, etc.)

From here, you can modify & print the Excel sheet, close it, close Excel, )erase EX
or from APL, you could do these actions separately under program control, as in:

(EX.Workbook.Item 1).Close 1
EX.Quit Ï ÁEX 'EX'
Excel Charts?

)ED XLCHART

(?? does this work)

More on Charts?: see David Crossley's XL functions workspace (not trivial), eg.

xl_start'' Ï xl_plot 1¶°20

APL Borealis Inc. - www.aplborealis.com
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A Few More Tips & Tricks
XL.Workbooks[1].Sheets[1].Activate
XL.ActiveSheet.UsedRange.Count
XL.ActiveSheet.UsedRange.Address ''
XL.ActiveSheet.UsedRange.Select

Æ "activate" a worksheet

Æ select a range

Result of Single vs. Multiple Cell Values

(XL.ActiveSheet.Range'C1').Value2
(XL.ActiveSheet.Range'C1' 'D1').Value2

Æ depends on cell content (empty?)

Named Ranges (for template-driven output?)

(XL.ActiveSheet.Range'E5' 'H9').Name ¢ 'MyRng1'
(XL.ActiveSheet.Range'MyRng1').Value2 ¢ mat3

Æ populate known ranges

Multi-Area Ranges

(XL.ActiveSheet.Range'C7:D9,F7:G9').Name¢'myrng2'
(XL.ActiveSheet.Range'myrng2').Value¢(3 2±°6)(3 2±100+°6) Æ ??
(XL.ActiveSheet.Range'myrng2').Value¢(3 2±°6),(3 2±100+°6)
(XL.ActiveSheet.Range'myrng2').Areas.Count
((XL.ActiveSheet.Range'myrng2').Areas[2]).Value2¢99 Æ scalar extension!
Conclusion: we can only pass a simple (non-enclosed) argument, so one APL array gets split into subarrays according to target-cell geometry in Excel.

APL Borealis Inc. - www.aplborealis.com
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A Few Other Nifty Things... OLE!
We can launch other OLE applications and/or create documents from APL:
PowerPoint
•
•
•
•

find the PowerPoint OLEServer object
create an OLEClient object which uses the PowerPoint server
explore the server object properties & methods
create an APL driver function which will open and run a PowerPoint .pps file

Word
In similar fashion to Excel, we link APL to the OLE Server object for MS-Word, then set or query its various subobjects, etc.
• study the VB code in some of the following: (ie. Google "Word OLE Automation")
 http://vbcity.com/forums/topic.asp?tid=34572
 http://groups.google.ca/group/comp.lang.basic.visual.misc/browse_thread/thread/5f469ecaf624045b/a63af721
977b6c7f?lnk=st&q=%27Running+Word+Using+Automation%27+InsertDateTime+MM-DDYY+HH%3AMM%3ASS&rnum=5&hl=en#a63af721977b6c7f
 http://support.microsoft.com/?kbid=250501
• emulate this code in APL and create an APL driver function to send arbitrary text to a Word document
OCX Demo
OCX Controls behave similarly to the OLE Server objects above, except they may need to be associated with a
Form or other container to be useful. These objects are designed to take on some of the properties of their
environment (container).
See: "Loading an ActiveX Control", in the Dyalog Windows Interface Guide (Chapter 11).
• use the 'Microsoft Forms 2.0 TextBox' OLE Control object by building an APL driver function to contain and
present this object
PDF
Similar to the OCX control above, Adobe Acrobat provides an ActiveX control which can be used to display a
PDF document.
• find the Adobe Acrobat ActiveX component needed to display PDF documents
• create an APL driver function which will display a given PDF document

APL Borealis Inc. - www.aplborealis.com
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What Else Is New?
1. ÁWX changes - see Session Help "Latest Enhancements": "Expose Windows Object Properties" and "External
Object Behaviour"
2. ÁNL and COM Objects - see: Session Help "Latest Enhancements", ÁNL, ÁNC and "name-class" definitions
Extensions for more detailed object information.

3. APL Classes based on OLEClient - see:
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Excel in Control
Here, we focus on designing the user interface in Excel/VBA. APL may be "plugged into" this application as a
black box, hidden from view normally. APL functions are passed arguments, and return results as with any other
Excel/VBA function. Excel is the client, APL the server (often called "calculation server or engine").
In General
Calling APL functions from within your Excel application involves the following steps:
•
•
•
•

create appropriate APL code in a workspace, with some special considerations; test and debug
create/register the required .dll using this code
create the Excel spreadsheet, including VBA code which links into APL code
test and debug

In Dyalog APL, we use a Namespace object to contain the code which Excel will call upon, and Dyalog provides
a special facility to turn that code into a .dll file.

Dyalog APL provides a built-in facility in the session manager for creating the required .dll object which will
deliver APL capability to your Excel application. This is documented in the Dyalog APL "Interface Guide"
(Chapter 12: "OLE Automation Server").
Worth reading in that chapter:
• Rules for Exported Functions
• Out-of-Process and In-Process OLE Servers
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Key steps include:
• Create an APL workspace containing a namespace, into which all the relevant code and other objects are
placed
• make the namespace an OLEServer object, eg.

Loan.ÁWC 'OLEServer'

• )SAVE the workspace (use a new name if starting with one of the demos)
• Choose File-Export from the menu, and select "In Process Server (*.dll)" or "Out of Process COM Server"
(typically "In Process" - see Dyalog's Interface Guide)
Dyalog APL will automatically package up the namespace contents, "export" those items, and register the
supplied Namespace as a .dll object (and produce a small log/report). This .dll is the object we then refer to in our
Excel/VBA code, using the CreateObject function.
On the VBA/Excel Side
• Create your spreadsheet - typically this will be designed with input areas for data parameters to be passed to
APL, and one or more "controls" (buttons, input boxes, etc.)
• Enter "Design Mode", using the toolbar brought into view by: View > Toolbars > Control Toolbox
• Right-click on controls to choose "View Code" or "Properties"; or enter the VBA Macro editor to modify these
Let's look at the supplied example: ...\samples\ole\loan.xls
Private Sub CBGet_Click()
(or use the "Assign Macro" feature)
Dim APLWS As Object
Set APLWS = CreateObject("dyalog.NAMESPACENAME")
...
Sub Calc()
Dim APLLoan As Object
Dim Payments As Variant
Set APLLoan = CreateObject("dyalog.Loan")
LoanAmt = Cells(1, 3).Value
LenMax = Cells(2, 3).Value
LenMin = Cells(3, 3).Value
IntrMax = Cells(4, 3).Value
IntrMin = Cells(5, 3).Value
APLLoan.PeriodType = 1
Payments = APLLoan.CalcPayments(LoanAmt, LenMax, LenMin, IntrMax, IntrMin)
For r = 0 To UBound(Payments, 1)
For c = 0 To UBound(Payments, 2)
Cells(r + 1, c + 5).Value = Payments(r, c)
Next c
Next r
End Sub
Sub CalcPayments()
...

(alternate coding to above)
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The Tricks
For Dyalog APL, the following rules and caveats apply at creation time, when creating the .dll through the above
process:





all functions must be niladic or monadic; no dyadic functions, nor dynamic functions, derived functions or
operators; this could lead to numerous code changes obviously for some existing systems
any global variables cannot be enclosed arrays
results (returned to Excel) may be simple or enclosed
reporting exceptions, errors, etc. back to Excel can be a chore, depending on desired level of detail

Valence
Make dyadic functions monadic, by combining the arguments into one:

R¢„CAT1 ARG;A;B;SA;SB
[1] Æ catenate 2 tables on the 1st axis
[2] A¢ÁIO»ARG Ï B¢(ÁIO+1)»ARG
[3] A¢(SA¢Ô2¸†1 1,±A)±A Ï B¢(SB¢Ô2¸1 1,±B)±B
[4] R¢0,1¹SA§SB Ï SB¢R§SB Ï SA¢R§SA
[5] R¢(SA¸A),[ÁIO]SB¸B
Then, change the syntactic use of each function which has changed, eg.

C¢„CAT1 (A B)
Globals
Create "make" functions instead of globals, and invoke these in a "QUADLX" function which is called by VBA
before calling any other code, or invoke them as needed at the beginning of other processes or functions, eg.

MAKEÒFrequencies
Frequencies¢6 2±CUT'/D/DAILY/W/WEEKLY/M/MONTHLY/Q/QUARTERLY/S/SEMI/Y/YEARLY'
Frequencies¢261 52 12 4 2 1,Frequencies
Error, Exceptions
Error handling can be as (un)sophisticated as you wish, but consider these suggestions:




do as much input-checking "up front", ie. in Excel, before sending bad info to APL
modify your APL code to always return a result, being an error message or valid result; ie. let Excel deal with
the result according to content
return an error code with all results from APL (0 = OK; 1 = not OK, etc.)
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A Few Other Issues
1. A hierarchy of Namespaces in your server application?

2. Running your server application on a network?

3. Calling your server asynchronously, see the OLEASYNC workspace, and:
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4. Writing ActiveX Controls in Dyalog APL - see Interface Guide, Chapter 13
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ADO and Dyalog APL
Using DAO (precursor to ADO) Dyalog allows us an easy-to-use facility for exploring SQL-based data sources:

)LOAD c:\...dyalog...\samples\ole\oleauto
TESTDB¢ 'c:\...\fpnwind.mdb'

Æ the MS-Access "NORTHWIND" sample DB

SEL¢'Select * from Customers where Country = ''Canada'''
TESTDB SQL SEL
TESTDB LIST_FIELDS SEL
With time, one could dive into the SQL function code and create new options for more elaborate selections,
update mechanisms, etc.
For databases other than MS-Access and the like, Dyalog offers the ODBC interface tools (Chapter ?? - Interface
Guide) which provide a complete and detailed set of utilities for interacting with any of these data sources. This is
non-trivial in scope.
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